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	Tema 3: Construirea unui mediu tridimensional în Unity
Rezultatele învățării preconizate a fi atinse: RÎ5; RÎ6

	Cunoștințe / unități de conținut
	Abilități
	Responsabilitate și autonomie

	Termeni cheie: 
scenă, obiecte 3D, lumină, cameră, material, shader, textură.
Unități de conținut:
Subteme:
· Principii de navigare și manipulare în spațiul tridimensional.
· Crearea și poziționarea obiectelor 3D primitive și importate.
· Sisteme de iluminare: tipuri de surse de lumină și efectele lor asupra scenei.
· Configurarea și utilizarea camerei pentru urmărirea și redarea scenei.
· Utilizarea materialelor, shaderelor și texturilor în dezvoltarea vizuală.
Activități de laborator:
· Crearea unei scene 3D realiste cu obiecte, teren și lumină.
· Aplicarea diferitelor tipuri de lumină (Directional, Point, Spot).
· Configurarea camerei pentru vedere cinematică.
· Importul și aplicarea texturilor pe obiecte.
· Testarea umbrei și efectelor de iluminare.
	✓ Se navighează și se manipulează obiectele în spațiul tridimensional folosind uneltele de poziționare, rotire și scalare.
✓ Se creează scene 3D cu obiecte primitive și importate din surse externe.
✓ Se aplică și se compară diferite tipuri de surse de lumină pentru a înțelege efectul lor asupra mediului virtual.
✓ Se configurează camerele pentru a obține unghiuri cinematice și perspective coerente în joc.
✓ Se aplică texturi, materiale și shadere pentru a îmbunătăți realismul vizual al scenei.
✓ Se testează și se ajustează umbrele, luminozitatea și reflexiile pentru a obține un efect vizual echilibrat.
✓ Se integrează elemente vizuale într-o scenă coerentă și funcțională din punct de vedere estetic.
	✓ Se implică activ în conceperea și decorarea unei scene 3D complexe.
✓ Lucrează în mod autonom pentru a regla compoziția scenei și iluminarea.
✓ Propune soluții creative în alegerea texturilor și poziționarea camerei.
✓ Cooperează cu colegii pentru a menține un stil vizual unitar.
✓ Evaluează critic rezultatele vizuale și ajustează scena în funcție de feedback.








1. [bookmark: _Toc21274]Principii de navigare și manipulare în spațiul tridimensional
a) [bookmark: _Toc25230] Navigarea în Scene View:
Click dreapta + W/A/S/D – mișcare liberă în scenă
Click stânga + Alt – orbitare în jurul obiectului
Scroll Mouse – zoom in/out
F – centrează camera pe obiectul selectat
b) [bookmark: _Toc28713]Manipularea obiectelor:
Q – Select Tool
W – Move Tool (săgeți pe axele X, Y, Z)
E – Rotate Tool (cercuri colorate)
R – Scale Tool (cuburi pe axă)
T - Rect Tool (pentru UI)
[image: ]
Table 1 Manipularea obiectelor
Move Tool (W)
Trage de săgețile colorate (roșu = X, verde = Y, albastru = Z)
Poți mișca obiectul doar pe o axă sau pe un plan

Rotate Tool (E)
Rotește obiectul în jurul axelor X, Y, Z
Cercul galben exterior rotește în jurul camerei

Scale Tool (R)
Redimensionează obiectul
Poți face scalare uniformă (în toate direcțiile) sau pe o singură axă

Notă importantă: sistemul de coordonate
Unity folosește un sistem 3D de coordonate:
· X – orizontal (stânga-dreapta)
· Y – vertical (sus-jos)
· Z – adâncime (în față / în spate)
Poziționarea unui obiect este definită prin Vectorul (X, Y, Z).
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Table 2 Sistem de coordinate
[bookmark: _Toc19493]Obiectiv: Creează un sistem simplu de obstacole într-un nivel de test.
· Creează un Plane → acesta va fi solul.
[image: ]
Table 3 Plane
· Creează un Cube → acesta va fi un obstacol.
[image: ]
Table 4 Cube
· Selectează cubul și folosește W → mută-l la (2, 0.5, -3)
· Folosește E → rotește-l 45° pe axa Y.
· Folosește R → scalează-l (2, 1, 2) → devine un bloc lat.
După ce ai poziționat obstacolul, copiază-l (Ctrl + D) și creează o linie de 5 obstacole.
[bookmark: _Toc16315]Folosește pivotul și orientarea corectă
Din bara de unelte (colțul stânga-sus în Scene View), poți comuta între:
· Pivot / Center – transformă în jurul centrului obiectului sau al grupului
[image: ]
Table 5 Pivot
[image: ]
Table 6 Pivot
· Local / Global – axele urmează orientarea obiectului sau a lumii
Pentru obiecte rotite, folosește „Local” pentru o manipulare mai intuitivă.
[image: ]  [image: ]
Table 7 Local
Table 8 Global
[image: ]
Table 9 Switch orientation
Exercițiu practic:
Creează un Cube, apoi:
Mută-l 3 unități pe axa X
Rotește-l 45° pe axa Y
Mărește-l pe axa Z cu 1.5x
2. [bookmark: _Toc19595]Crearea și poziționarea obiectelor 3D primitive și importate
a) [bookmark: _Toc13523]Obiecte primitive:
GameObject → 3D Object → Cube / Sphere / Capsule / Plane / Cylinder
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Table 10 3D Obiecte
· Se folosesc pentru blocarea nivelului, testarea coliziunilor, prototipare.
· Poți schimba dimensiunea cu Transform > Scale, poziția cu Position.
b) [bookmark: _Toc16259]Importul de modele 3D:
· Creează folderul Models/
· Trage fișiere .fbx, .obj sau .blend în folderul respectiv
· Unity creează automat un prefab cu mesh-ul importat

[bookmark: _Toc17869]Crearea obiectelor 3D primitive
Tipuri de primitive disponibile:
Se creează din meniu: GameObject > 3D Object > …
	Obiect 3D
	Descriere
	Utilizare frecventă

	Cube
	Cub standard (1x1x1)
	Ziduri, cutii, obstacole

	Sphere
	Sferă
	Proiectile, obiecte de decor

	Capsule
	Cilindru rotunjit la capete
	Jucători, NPC-uri

	Cylinder
	Cilindru vertical
	Coloane, copaci

	Plane
	Suprafață plată mare (10x10)
	Solul scenelor, platforme

	Quad
	Plan 2D (1x1)
	Pentru UI 3D, texturi



[bookmark: _Toc11538]Importul obiectelor 3D din alte surse
· .fbx – cel mai recomandat (universal, compact)
· .obj – compatibil, dar fără animații
· .blend – fișier nativ Blender (necesită Blender instalat)
· .dae, .3ds, .max, .ma – suport limitat/dependență software
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Table 11 Export Package
[bookmark: _Toc329]Pași pentru import:
· Creează un folder nou: Assets/Models/
· Deschide File Explorer → trage fișierul .fbx sau .obj în folder
· Unity importă automat modelul și îl afișează cu o icoană gri
· Trage modelul în scenă din folderul Models/
· Creează din el un prefab pentru reutilizare (drag în folderul Prefabs/)

Sfaturi la import:
· Dacă modelul apare prea mare/mic, modifică Scale Factor în Inspector (Model tab).
· Activează Generate Colliders dacă vrei ca modelul să detecteze coliziuni.
· Setează Normals și Materials pentru afișare corectă.

Unity Assets Store:
	Package Manager -> Import

[bookmark: _Toc15683]Site cu 3d models:
1. [bookmark: _Toc7018]https://sketchfab.com/feed
2. [bookmark: _Toc22244]https://www.turbosquid.com/
3. [bookmark: _Toc15892]https://www.turbosquid.com/
4. [bookmark: _Toc10582]https://free3d.com/

Tool-uri de transformare:
	W – mutare
E – rotație
R – scalare
[bookmark: _Toc31757]Recomandări pentru poziționare curată
Folosește grilajul vizual pentru aliniere
Grupează obiecte (Empty GameObject ca părinte)
Folosind Snap Settings (Edit > Snap Settings):
Mișcare la pas fix: Ctrl + Drag
Rotație la 15°: Ctrl + E
Folosește Pivot / Center și Local / Global în Scene View (colțul din stânga sus)
3. [bookmark: _Toc8609]Sisteme de iluminare: tipuri de surse de lumină și efectele lor asupra scenei
Iluminarea este esențială în dezvoltarea vizuală 3D — ea determină modul în care obiectele sunt percepute în spațiu, adaugă atmosferă, profunzime și claritate vizuală. Unity oferă un sistem flexibil, cu mai multe tipuri de surse de lumină, configurabile pentru diferite scopuri (jocuri realiste, stilizate, horror, low-poly etc.).
	Tip lumină
	Descriere
	Exemplu

	Directional Light
	Lumină uniformă dintr-o direcție, ca soarele
	Iluminarea întregii scene

	Point Light
	Lumină care radiază în toate direcțiile
	Lampă, torță

	Spotlight
	Con de lumină direcțional
	Lanternă, far de mașină

	Area Light
	Doar în HDRP – sursă pătrată
	Neoane, panouri



[image: ]
Table 12 Light
[bookmark: _Toc1579]Setări importante:
Intensity – puterea luminii
Range – raza efectului
Shadows – realiste vs. Performanță
 Exercițiu practic:
Adaugă un Point Light deasupra unui cub
Modifică Range și Intensity
Schimbă tipul umbrei la „Soft Shadows”
[image: ]
Table 13 Settings Light
[bookmark: _Toc3437]Tipuri de surse de lumină în Unity
a) [bookmark: _Toc31479]Directional Light
Lumină globală, direcționată, ideală pentru simularea soarelui.
· Afectează TOATE obiectele din scenă, indiferent de poziție.
· Nu are „poziție”, doar direcție.
· Se comportă ca lumina soarelui: raze paralele.
Parametri principali:
· Intensity – cât de puternică este lumina
· Color – culoarea luminii (ex: portocaliu la apus)
· Shadows – poate proiecta umbre (Hard/Soft)
Când se folosește: pentru scene de exterior, ziua, open-world.
Exemplu:
Un joc ca The Legend of Zelda: Breath of the Wild folosește o Directional Light ca sursă principală de lumină solară.
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Table 14 Direction Light

b) [bookmark: _Toc662]Point Light
Lumină care emite în toate direcțiile de la un punct fix – ca un bec sau o torță.
· Afectează obiectele în interiorul sferei de rază (Range).
· Intensitatea scade cu distanța (dacă e activat Attenuation).
Parametri principali:

Range – cât de departe luminează
Intensity – cât de puternică e lumina
Color – culoarea luminii
Shadows – umbre proiectate sferic
Când se folosește: în interioare, pe tavan, în coridoare.
Exemplu:
Într-un dungeon 3D, fiecare torță poate avea o Point Light cu lumină portocalie caldă și intensitate redusă.
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Table 15 Point Light
c) [bookmark: _Toc11377]Spotlight
Proiectează un con de lumină într-o anumită direcție – ca o lanternă sau un proiector.
· Are un unghi de deschidere (Spot Angle) și direcție
· Ideală pentru efecte dramatice, focus vizual sau iluminare teatrală
Parametri principali:
· Spot Angle – lățimea conului de lumină
· Range – distanța maximă
· Intensity – puterea luminii
· Shadows – umbre precise în con
Când se folosește: lanterne, faruri, reflectoare, scene nocturne.
Exemplu:
Într-un joc stealth, jucătorul trebuie să evite conul de lumină al unui paznic (Spotlight cu detectare trigger).
[image: ]
Table 16 Spot Light
d) [bookmark: _Toc6249]Area Light (doar în HDRP sau în baking)
Sursă de lumină plată, ideală pentru simularea neoanelor sau ferestrelor.
· Nu este suportată în modul de randare Standard în timp real
· Necesită High Definition Render Pipeline (HDRP) sau baking
Când se folosește: în scene realiste, vizualizări arhitecturale.
[image: ]
Table 17 Area Light
Efectele surselor de lumină asupra scenei
1. Umbre (Shadows)
Hard Shadows – margini dure, performanță mai bună
Soft Shadows – margini difuze, realism crescut
Se activează din Inspector: Cast Shadows și Receive Shadows
2. [bookmark: _Toc21714]Culoarea și intensitatea
Culoarea luminii afectează starea scenei (caldă, rece, sinistră)
Intensitatea prea mare poate „arde” obiectele vizual
Reglaj fin al balansului între lumină ambientală și surse locale

Setări globale de iluminare
Se accesează din:
Window → Rendering → Lighting → Environment
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Table 18 Lighting
Aici poți configura:
· Skybox – fundalul scenei (cer, spațiu etc.)
· Ambient Lighting – lumină de bază din toate direcțiile
· Reflection Probes – pentru reflexii realiste
· Global Illumination (GI) – lumină indirectă (în HDRP/URP)
Baking: procesul prin care Unity „înregistrează” luminile statice pentru performanță crescută.

Sfat
Nu folosi prea multe lumini active în scenă – afectează performanța
Setează Light Mode = Mixed pentru obiectele statice + dinamice
Dacă un obiect trebuie doar iluminat, dar nu emite umbră – dezactivează Cast Shadows pentru optimizare
4. [bookmark: _Toc10198]Configurarea și utilizarea camerei pentru urmărirea și redarea scenei
Camera este GameObject-ul care definește ce vede jucătorul într-o scenă. Orice joc 3D (și multe 2D) are cel puțin o Main Camera, care captează imaginea scenei și o redă pe ecran în Game View.
Fără cameră → nu se va vedea nimic la rularea jocului.
Camera în Unity:
Orice scenă are o Main Camera
Controlează ceea ce „vede” jucătorul
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Table 19 Camera
Parametri importanți:
Field of View (FOV) – unghiul camerei
Clipping Planes – cât de departe/aproape „vede” camera
Clear Flags – fundalul (Skybox, Solid Color etc.)
[image: ]
Table 20 Camera Settings
Urmărirea jucătorului (script simplu):
public Transform target;
void LateUpdate() {
    transform.position = target.position + new Vector3(0, 2, -5);
    transform.LookAt(target);
}
Exercițiu practic:
Creează un personaj (Capsule)
Atașează un script de cameră care îl urmărește
Rotește camera să privească obiectul în timpul jocului

· [bookmark: _Toc14976]Componente și parametri ai camerei
Când selectezi camera în scenă, în Inspector apar mai multe opțiuni esențiale:
a) Projection
· Perspective – simulare realistă a adâncimii (obiectele mai îndepărtate par mai mici)
· Orthographic – fără perspectivă (folosit mai ales în jocuri 2D sau strategiile isometrice)
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Table 21 Perspectiva
Exemplu:
Perspective → jocuri FPS, RPG, simulatoare
Orthographic → Stardew Valley, Age of Empires
b) Field of View (FOV)
Doar în modul Perspective
Unghiul camerei – determină cât de mult din lume este „vizibil”
	Valoare FOV
	Efect vizual

	30–40
	Imagine „telephoto” (zoom-in)

	60 (default)
	Unghi natural, echilibrat

	90+
	Wide angle, efect de distorsie


[image: ]
Table 22 Field of view
c) [bookmark: _Toc12819]Clipping Planes
· Near – cel mai apropiat punct vizibil (default: 0.3)
· Far – cel mai îndepărtat punct (default: 1000)
Reducerea Far Plane-ului ajută la performanță și elimină obiectele nevăzute.
d) Clear Flags
Definește ce se vede în fundal:
	Opțiune
	Descriere

	Skybox
	Fundal bazat pe cerul scenei

	Solid Color
	O culoare unică (ex: negru pentru jocuri horror)

	Depth Only
	Doar partea de adâncime este considerată (cameră dublă)

	Don’t Clear
	Păstrează frame anterior – rar folosit



e) [bookmark: _Toc1173]Culling Mask
Poți seta ce obiecte să fie vizibile pentru această cameră, folosind Layer-e.
Exemplu:
Ai o cameră „Map View” care vede doar elementele de hartă
Ai o cameră secundară care vede doar UI 3D
· Poziționarea camerei în scenă
Camera este un GameObject, deci are componenta Transform:
Position: unde se află în lume
Rotation: unghiul din care „privește” scena
Bine de știut: Dacă rotești camera greșit, scena poate apărea „peste cap” sau în lateral.
· Urmărirea unui obiect – cameră „dinamică”

5. [bookmark: _Toc18828]Utilizarea materialelor, shaderelor și texturilor în dezvoltarea vizuală
[bookmark: _Toc19621]Materiale:
Se creează din Assets > Create > Material
[image: ]
Table 23 Material
Atribuie o culoare, textură sau shader
Se aplică pe obiecte prin drag & drop sau din Inspector
[bookmark: _Toc30478]Texturi:
Imagini .png, .jpg aplicate pe obiecte
Se atașează la slotul Albedo din Material
[bookmark: _Toc8103]Shadere:
Scripturi vizuale care controlează modul în care este redat 	materialul
Unity include:
Standard Shader – bun pentru majoritatea cazurilor
Unlit – fără iluminare
URP/HDRP Shaders – pentru proiecte avansate

Un scenariu comun: vrei ca Main Camera să urmărească jucătorul (ex: o capsulă sau un personaj).
public class CameraFollow : MonoBehaviour
{
    public Transform target;
    public Vector3 offset = new Vector3(0, 3, -6);

    void LateUpdate()
    {
        transform.position = target.position + offset;
        transform.LookAt(target);
    }
}
Pași pentru implementare:
Creează un GameObject jucător (ex: Capsule)
Creează un script CameraFollow.cs
Atașează scriptul la Main Camera
Trage Capsule în câmpul Target din Inspector
Rulează scena: camera urmărește jucătorul de la distanță
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